
FastCAM® Software

Tutorial

FastCAM Inc.
FastCAM China
FastCAM Pty. Ltd.

This tutorial supplements our classroom training material 
however due to the demand from remote customers unable 
to attend face-to-face training, we have made it freely 
available.



I. FastCAM Installation

Selection of the correct NC controller is an important step in the 
software installation. If uncertain, the correct controller can be verified 
on the cutting machine or by direct contact with the machine 
manufacture.

Installation & Setup



Installation Notes

▪ During software installation, it is essential to select the correct controller 
and code format for your specific controller type.  If you don’t do this 
correctly you will get error problems.   Machines and controllers are not 
always the same.  You need to check the cutting machine documentation 
or ask the machine builder if you are not sure.

Remarks:

1. You may need to reinstall FastCAM in the future.  It is important to make a 
backup copy of the controller setup file.

2. Other types of controllers for Oxy Flame and Plasma cutting system are 
EDGE, BURNY, FastCNC, START, KANGPU … etc.

3. Common controller types for LASER cutting system are FAGOR, PA8000, 
SIEMENS … etc.



II. FastCAM System and Controller Settings are in the SETUP.DAT file and 

Control file these are normally located C:\program files\fastcam\
Occasionally these files may need to be edited for specific machines. If 
in Doubt contact your supplier or FastCAM Service.

Note: NC output files do not always end in [filename].CNC

Other popular extension names are TXT and NC and some have no extension.

Installation and Setup



Installation & Setup Up

III. Controller Setting (*.con file, * stands for the controller type, e.g. Edge.con)



Notes:

Editing the controller setup file.

SETUP.DAT is an important file for setup of the 
controller which stores the name and type of the 
controller together with the related settings.

Changing the content of this file may cause 
operational problems. Details of this file can be found 
in the FastCAM reference manual.

Note: For accuracy, precision LASER cutting is set to 
0.01 mm in FastCAM.



Notes- Editing the controller setup file *.CON

*.CON (e.g. FAGOR.CON, EDGE.CON) is another 
important file for setup of the controller because it stores 
commands for the cutting machine. For further details, 
please check the FastCAM reference manual or contact 
our technical staff. Content of the file should not be 
changed if the NC Codes and their exact meaning are not 
understood.

Important:
For software re-installation in the future, please make a 
copy of the 2 controller files (SETUP.DAT and *.CON) and 
keep in a safe place. These documents can be found in 
the FastCAM installation directory eg: C:\Program 
Files\FastCAM



FastCAM System 
Overview

I. FastCAM Application
Process

Draw -> Nest -> Cut
All in One program.

We discuss, illustrate and 
demonstrate each
function.

Import CAD files from 
AutoCAD and other 
CAD products

or
Create part drawings 
with FastCAM Editor 
with CAM/DXF/DWG 
output

Optimize cutting 
paths and process 
parameters

Optimize material 
usage with mixed 
nesting, common 
edge cutting and 
remnant nesting

Check and cost parts 
before cutting

Optimized NC code for 
quality cutting



Module 1   The Part Drawing - 45 minutes
Lesson 1: FastCAM Drawing Editor Quick Study (10 minutes) 
Lesson 2: FastCAM Drawing Editor Full Study       (30 minutes)
Lesson 3: Working with CAD files                        (30 minutes)

Module 2   NC Path Setting - 45 minutes
Lesson 3: Manual Path Setting (15 minutes)
Lesson 4: FastPATH Automatic Path Setting (30 minutes)

Module 3   Part Nesting - 45 minutes
Lesson 5: Manual Part Nesting (15 minutes)
Lesson 6: Automatic Mixed Part Nesting (30 minutes)

Module 4   Optimized Cutting– 45 minutes
Lesson 7: Automatic Common Cutting (15 minutes)
Lesson 8: Bridges for Plasma Cutting (15 minutes)
Lesson 9: Automatic Continuous Cutting (15 minutes)
Lesson 10: Nesting exercises

Module 5   FastCAM Solutions

Appendix:  Technical Notes

- END -
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FastCAM Drawing Editor

- Quick Study

FASTCAM Drawing Editor

- Full (self) Study

Fundamentals:

 Point, Line and Arc

 Erase, Trim, Blocks, View, Utility and Text

 Text, Verify and Standard Parts



Drawing

The FastCAM drawing editor is a simple 2D drawing tool which 
requires little or no previous CAD experience. 

FastCAM has drawing functions similar to AutoCAD without the 
complexity. It has been developed specifically for steel cutting 
and for use by trades people. 

It also provides many standard features required commonly by 
industrial cutting such as different types of bridges and stitches. 
With LASER cutting, there is choice for process techniques such 
as internal corner to fillet, external corner with fillet or chamfer, 
contour to slot and hole to point.

CAD Note:
1. For people already familiar with a CAD program, it is not necessary to learn 
the FastCAM drawing editor.  However to prevent cutting problems, it is 
important to use the inbuilt data optimizer and to verify paths are closed before 
nesting.  Please browse through this section or go directly to Lesson 2 (Slide 31).



1. Drawing exercise

1.1: Quick Study A:  Draw a Basic Shape



Instructions to Create a Basic Shape:

1. Select ‘Line - 2 points’ button under the menu bar, right click on any blank 
screen area and select ‘Screen position’. 

2. Left click on screen to define the first point ‘A’ followed by right click to select 
‘incremental co-ords’. 

3. Using ‘A’ as the reference point to define point ‘B’, enter (600, 0), enter and 
exit to main menu.

4. Select ‘Angle only’ from the ‘Line’ menu, left click ‘A’ as the reference point 
and select ‘relative to’ from pop up. 

5. Left click on previous drawn line close to ‘B’, enter 70 for degree in the dialog 
box and press ‘ESC’ until back to main menu.

6. Select ‘Parallel at dist.’ from the ‘Line’ menu, left click on line AB and enter 
300, click on screen above line AB to indicate the required side and select 
infinite line from pop up. 

7. Using ‘Angle only’ from the ‘Line’ menu, pick ‘B’ as the reference point to 
draw the line BC.

8. Select ‘Smart trim’ from the ‘Trim’ menu and left click on lines outside of the 
required shape to complete this exercise.



1. Drawing exercise

1.1: Quick Study B.  – Draw a ‘Widget’



Instructions to create a ‘Widget’ (JACKSON PLEASE BREAK DOWN INTO STEPS)

1. Select ‘Line 2 points’ button from menu, click on screen to define point ‘A’ followed by 
right click and select ‘incremental co-ords’ from pop up. Enter 150 and 0 in dialog box to 
complete drawing of line AB. Click on ‘B’ as the reference point, right click to select 
‘incremental co-ords’ and enter 0, 60 for line BC. Click on ‘C’ as the reference point, right 
click to select ‘incremental co-ords’ and enter 300, 0 for line CD. Click on ‘D’ as the 
reference point, right click to select ‘incremental co-ords’ and enter 0, -60 for line DE. 
Click on ‘E’ as the reference point, right click to select ‘incremental co-ords’ and enter 
150, 0 for line EF. Click on ‘F’ as the reference point, right click to select ‘incremental co-
ords’ and enter 0, 100 for line FG. Select ‘Line 2 points’ button from menu, click on ‘A’ as 
the reference point, right click to select ‘incremental co-ords’ and enter 0, 100 for line AH. 
Select Ring from the Arc menu, enter 120 and 300 as diameter of rings in the dialog box. 
Right click to select point A as the reference point and enter (300,400) as coordinate of 
ring centre. Select ‘Tan to Circle’ from the Line menu, click on outer circle of the ring, 
select given point and click on point H followed by right click to escape. Complete 
drawing of the tangent to point G with the same principle. Select Full Circle from the Arc 
menu, enter 180 as radius and pick point H as centre with an auxiliary circle drawn 
intersecting at I. Select ‘At Rt Angles’ from the Line menu and click on I with a 
perpendicular line drawn. Draw another circle with radius 100 and centre at I. Locate 
centre of circle with radius 30 from the intersection and draw the R30 circle. Create 
‘parallel lines at distance’ at point I from the Line menu. Continue to finish rest of the 
geometry and use smart trim to complete this exercise.



Other we suggest you try:

1.1: Other Fast Study Examples:



WIDGET
Here you will go through the process of drawing a part in FastCAM® based upon a scaled part 
drawing.  For example you might receive a drawing from a customer like the one below:

1.2.  FastCAM Drawing Editor – Full (Self) Study



With any drawing you do in FastCAM®, the first step is to identify the individual shapes 
within your part.  This may take some time at first, but with practice and experience, you 
will learn how to quickly evaluate and determine what entities are necessary to create a 
part.

In our WIDGET, it is important to notice there is a rectangle on the left side within the part.  
This rectangle also has two smaller internal circles.  On the right side, you can see a 2-circle 
ring.  The rectangle and ring appear to be blended together with two lines.

Rectangle Connecting Tangent Lines Ring



Once you have identified the different entities in the part, we start by running the 
FastCAM® drawing editor.  Upon opening FastCAM®, you should see the screen below.



To create drawings to scale, it is easiest to use absolute coordinates.  Absolute 
coordinates are based upon the Cartesian coordinate system as shown below.



If you are unfamiliar with the Cartesian coordinate system, it is a good idea to 
review or practice using this principle.  In FastCAM®, you can choose to display 
the x and y axis to assist you in drawing your parts.  Click on the View menu and 
select Change Display.  From here, check the box for Axes and then press ENTER.



You can start by drawing the rectangle.  It is best to do this using the Box feature. 
From the Line menu select Box.

By default, FastCAM® is set to draw a box using screen positions.  This function allows you 
to quickly draw rectangles by simply clicking on the screen but does not allow for parts to 
be drawn to scale.  To draw your part to scale, you must switch to the absolute coordinates 
by right clicking once on your drawing space and selecting Absolute Coordinates.



You can now enter the x,y coordinates for two opposite corners of you rectangle.  Based 
upon your drawing, you can enter two diagonally opposite corners of your box.  You can use 
a first point of (0,0), a second point of (0.5,2) and click ‘Enter’.



Many of the drawing functions in FastCAM® are repetitive. To get out of any command 
or popup window, you will need to right-click until the menu bar is back to active.



The rectangle should now be drawn to scale and appear on the screen as shown below. 
When drawing items, FastCAM® often automatically prompts for a second item to be 
drawn.  If this is not desired, you may simply hit cancel and right click on the screen 
repeatedly to get out of any popup windows.

The next step would be to create the other side of our drawing (the rings.)  You could 
draw two full circles with the same center, but it is easier to use the Ring feature under 
the Arc menu.



FastCAM® will prompt you for an inside diameter and an outside diameter of the two 
circles that make up the ring.  Here you can key in .429 for the ID, 1.26 for the OD and 
click ‘Enter’.

Next, you will be prompted to select the center point for your ring.  Again, you can use 
absolute coordinates, key in (1.252,1) and click ‘Enter’.



You should now see a full ring just to the right side of your previously drawn rectangle.  
If at anytime you need to refresh your screen (if the image of your drawing is not 
clear), hit the Enter key once.

Finally, you need to draw lines to connect the rectangle to the ring.  There are many choices 
for drawing a line however, you can see from the scaled drawing that you need to use tangent 
lines.  Therefore, you need to select the Tan to circle option under the Line menu.

You will first need to select the arc (circle) in order to start the line.  To do this you must click 
on the outer circle on the nearest side to where the line will intersect.



Note : Horizontal infinite line will be created by left-click of mouse cursor at the 
approximate 6 and 12 O’clock positions. Likewise, vertical infinite line will be drawn 
by left-click of mouse cursor at the approximate 3 and 9 O’clock positions.

FastCAM® will then prompt you to choose an angle or a given point as an endpoint of 
your line.  In this situation, you will want to select Given point and then click on the 
upper right-hand corner of the rectangle.  After selecting Given point, the program will 
automatically switch to Control Points (from Absolute Coordinates) as can be seen by 
the prompt message on the screen.  This means that as long as you click near the point, 
the line will “snap” exactly to this point.  These points are called control points and you 
can see them in green and red below.



Repeat these steps for the other connecting line and you should then have the same as 
the drawing below. Be sure that you clicked at the appropriate point on your entity and 
that the correct tangent line appears.

Our part is now drawn except for a couple of internal circles.  First, you can zoom into this 
part by choosing Autoscale under the View menu, or by hitting the number 5 on the 
numerical keypad of your computer.



To draw a circle, go back up to the arc menu and select Full circle.

FastCAM® will ask for the radius of the circle.  Since we have the diameter, we can 
simply enter the diameter followed by the letter “d” as shown below and click ’Enter’.



We can then enter the absolute coordinates of the lower internal circle based upon our 
scaled drawing.  After you enter the diameter, you may have to right click and select 
absolute coordinates.

Many drawing functions in FastCAM® are repetitive, and the Circle function is one of 
them. Once we have drawn the first FastCAM® prompts us for another set of Absolute 
Coordinates for the next circle location. In this example it is easiest to use Incremental 
Coordinates, based on the drawing supplied.  To do this, right click once and choose to 
use incremental coordinates.



FastCAM® will ask if you want to use your previous point as your new reference point.  
Select yes, and enter coordinates based on that the point selected is now your 
reference of (0,0).

Now we need only the distance between the two circles, or the change in y value.



We now have a completed drawing, but need to erase some internal lines and arcs that 
are not  in our final drawing.  To erase a line which makes up part of the rectangle, go up 
to the Erase menu and choose Line.

Left click on the line you wish to erase once, and then right click on your drawing to 
fully erase this entity.



Now we can eliminate the last internal arc that is not part of the final drawing.  Go 
under the trim menu, and select Smart Trim.

Select the section of the circle that you wish to trim by clicking on the left side of the 
large circle of the ring that you want to trim.  The unwanted arc should be removed.



Now return to the View menu and uncheck the display axes box to remove them from 
your drawing.  You will then see your completed WIDGET drawing.



Finally, there are a number of ways to verify the scale of your drawing.  The quickest 
way is to go under the View menu, choose Change display, and check the box next to 
Auto Dimension.  Then click okay to view the dimensions of your part drawing.

We can see our part meets the dimensions of our scaled part drawing.  We can be 
confident that we have created a part with FastCAM® that is identical to our scaled 
drawing.



Module 1  Lesson 3

Working with CAD files

(30 minutes)



The following CAD features are integrated into the 
FastCAM Drawing Editor.

Main functions: 

(1) Clean imported CAD files for quality cutting.

(2) Compress CAD files to improve cutting speed.

Covers: DXF/DWG restore, explode, CAD layers,
text marking, dimensions, verify, simple/overcut
bridge, fillet corners … etc.

3.1   CAD Optimization



The Importance of Optimization of CAD Clean and Compress

The easy optimization and compression of CAD data is a valuable feature in FastCAM.

CAD systems are widely used for drawings and DXF/DWG files are often used in NC 
however they are not always ready for quality cutting. CAD systems often generates 
redundant points, overlapped lines, small-segment curves and open contours which 
produces NC output that may cause disordered machine travels, repetitive cutting, 
nesting problems, programming errors, frequent machine accelerations and 
decelerations leading to vertical machine jitter, poor cut quality, low productivity and 
shortened machine life.  

FastCAM’s CAD clean and CAD compress will fix all this automatically!

Illustrated Cutting Errors:
1. Internal hole double cut.
2. Incorrect position of entry and exit.
3. Part of line cut twice.

Purpose of CAD Clean:
1. Cleaning of all the redundant points to prevent disordered machine travels.
2. Cleaning of the repetitive entities to prevent incorrect entry/exit and double cutting.



The following exampled demonstrate :

Clean and Compress CAD files (Important for all cutting especially LASER)
To optimize the DXF/DWG data, FastCAM has been designed with the ability to 
automatically clean, compress and verify geometrical entities before they are saved to CAM 
files.

Automatic and manual path programming for single part cutting
NC codes can be generated with both the manual and automatic path setting method for a 
single part that has to be cut repeatedly.
Note:  The definition of a Single part can be more than one part contour or a combination 
of many parts grouped together but they will be processed as a single item.

Other settings and cutting functions
‘Extract Part’, ‘Explode Drawing’, ‘CAD Layers’, ‘Text Marking’, ‘Verify Dimensions’, 
‘Simple/Overcut Bridge’, ‘Fillets’, ‘Corner to (Fillets, Chamfer)’, ‘Offset Contour’, ‘Hole to 
Point’ …. are the common features for CNC LASER cutting. 



I. Purpose for CAD Clean

Lesson 3   CAD Optimization



II. CAD Clean result

Lesson 3   CAD Optimization



Brief description:

Total 17 entities. After the procedure of  ‘Erase’ → ‘CAD 
Clean’ → Dialog Box (You will eliminate 2 entities. Are you 
sure?) → (Yes) No, entities reduced to 15 with the case of 
double cut avoided.

Additionally, closure between curves and contours can be 
checked with the ‘Verify’ → ‘Contour’ function. Any open 
contour should be closed in the drawing editor, or the speed 
of nesting in FastNEST will be reduced and may not be able 
to complete. If the open gap is too small (less than 2mm), 
FastCAM will automatically take it as closed and the nesting 
speed will not be affected.



III. Purpose for CAD Compress

Lesson 3   CAD Optimization



IV. CAD Compress

Lesson 3   CAD Optimization



1270 entities remain after CAD clean but this is not the best 
number. As observed, there is a lot of red points around the 
numbers.

Description:
As observed, there is a lot of red points around the numbers and 
many of them are very close to each other. When NC codes are 
generated under this condition, vibration will occur during cutting 
which will cause damage to the machine. With CAD Compress, the 
situation can be improved by reducing the number of entities 
which is also good for those older controllers with smaller internal 
memory size.

Purpose of CAD Compress:
Compress and fit curves to reduce large amount of short-segment 
entities, minimize the amount of cutting instructions to avoid 
machine vibration. 
Compress and fit curves to reduce large amount of short-segment 
entities, avoid open gap between curves and contours, reduce 
accumulative cutting error for better quality and precision.



Useful CAD functions - Extract Part and Explode Drawing
With ‘Blocks’ → ‘Extract Part’ and ‘Blocks’ → ‘Explode Drawing’ to extract or explode multiple 
parts from DXF/DWG file for part nesting (typically used for nesting of ship components).

To improve the appearance of sharp corners in LASER cutting, corners can be rounded to 
fillets (e.g. 0.2 mm) as follows.
‘Program Path’ → ‘Round corners’ → ‘Corner radius’ – 0.2 mm → ‘Fillet inside corners?’ →

‘Yes’ → ‘Both’
Change to same setting in FastNEST (invalid for NC input file type) –
‘Nests’ → ‘Nest Parameters’ → select ‘Change corners’ → set corner distance, profile type … 
and press ‘Enter’ to confirm.

Steps:
ERASE → CAD Compress → CAD Clean? → NO → Max line length to round → ENTER →

Max shape divergence (current value 0.01mm) → ENTER (watch for any shape deviation) 
→ Compress arcs? → YES

Description:
1. Drawing entities reduced from 1270 to 992 after ‘ERASE’ → ‘CAD Compress’. This 

result can be further improved by applying ‘CAD compress’ again based on actual 
requirement. 

2. Indicate the max. line length of short segments. to be cleaned/compressed for 
reduction of program steps and higher cutting efficiency.

3. To avoid or minimize any effect of vibration in LASER cutting, value of ‘Max shape 
divergence’ should be 0.01 mm (precision value in file ‘SETUP.DAT’ needs to be 0.01 
mm).



Exercise - CAD Clean/Compress for DXF/DWG

Exercise 1

i. Compress number of entities in exercise ‘1.CAM’ 
from 9871 down to 518 and note there should 
be no change to its shape.

ii. Create your company name with a graphics 
program such as CorelDRAW and save as DXF 
format. Compress number of entities to 
minimum without change of shape in FastCAM 
for normal cutting.

Exercise 2

Check exercise ‘2.CAM’ and find the reasons why 
this part has more than 18 entities.

Lesson 3   CAD Optimization



Description:
Learn and master the purpose and method for CAD Clean and 
Compress by going through 4 exercises.

Summary of this section:
1. Learn and understand the importance of using CAD Clean 
and Compress to improve quality, nesting and cutting efficiency.
2. Learn and master the method and skills for CAD compress.
3. Learn and master the method for regular closure and 
restoration of closure.

Exercise 1
1. 19 and 0.7 are the 2 parameter values to avoid shape 
divergence.
2. Correct use of the 2 parameter values for compression.

Exercise 2
By checking the control points, we can find out what has gone 
wrong with this parts in showing 33 entities.



5 min. break



Module 2  NC Tool Path Programming

(45 minutes)

Lesson 3: Manual Path Programming (15 minutes)

Lesson 4: FastPATH Auto Path Programming (30 minutes)



Tool Pathing

NC path programming has a big impact on cutting 
speed and quality.

The FastCAM Professional Edition includes the 
FastPATH module which allows you to automate tool 
pathing and halve your programming time.



Lesson 3   Manual Tool Path Programming



Steps:
1. Select ‘DXF Restore’ from the ‘Files’ menu and deselect ‘Apply Z axis extrusion’. Pick file 

name from dialog box then select to load the required DXF into FastCAM. Check number 
of entities from top left of the screen and perform CAD Clean/Compress if it is required.

2. Select ‘Program Path’ → ‘Next Path’ → select operation (Cutting/Marker) → select 
left/right/none for kerf compensation → select contour

Must note below principles when doing manual setting:
1. Setting of path parameters for contours starting from internal cuttings to external cuttings.
2. For kerf setting with left compensation, direction of travel must be counter-clockwise for 

internal contours and clockwise for external contours. For kerf setting with right 
compensation, direction of travel must be clockwise for internal contours and counter-
clockwise for external contours. All contours should be set using the same principle or 
dimensional error will occur after cutting.

When doing manual setting for cutting paths, it is necessary to pay attention to the cut 
sequence, direction of travels and angle of entry/exit for both the internal and external 
contours. This is all about manual setting of the cutting paths and its procedure is actually 
the same as the automatic option. 

To tackle undercut problems occurring on corners during high speed cutting, round corner 
e.g. 0.2 can be added to paths automatically in FastCAM and FastNEST.



Lesson 3   Manual Tool Path Programming



Steps: Select ‘Program Path’ → ‘Next Path’ → select operation 
(Cutting/Marker) → select left/right/none for kerf
compensation → select contour

These principles apply to any manual setting:

▪ Setting of path parameters for contours start from internal 
cuttings to external cuttings.

▪ For kerf setting with left compensation, direction of travel 
must be counter-clockwise for internal contours and 
clockwise for external contours. For kerf setting with right 
compensation, direction of travel must be clockwise for 
internal contours and counter-clockwise for external 
contours. All contours should be set using the same principle 
or a dimensional error will occur after cutting.



I. FastPATH

This program is not shown individually on the desktop.

You can apply settings in FastCAM or FastNEST.

This program allows you to fully automate the setting of 
cut paths for optimum operation efficiency with:

Automatic setting of entries and exits.

Set kerf compensation.

You can also set various cutting techniques including 
common edge, bridging and common cutting.

Lesson 4   Automatic Path Programming



1. Cutting process

Lesson 4   Automatic Path Programming



Selection of machining process
Depending on functions available for your Machine, processes such as CUTTING, MARKER, OXY, PLASMA … etc can be selected 
from left of the box by double-click on item or left-click on the left arrow button. If several processes are required (which have not 
been specially defined), it will be necessary to set individual CAD layer in the FastCAM Editor for each process, e.g. set marking for 
1 layer and LASER cut for the other layer. Layers in FastSHAPES will be saved automatically to CAM file but they need to be 
defined for parts created in FastCAM or other systems. Specific settings can be checked from reference example. Selected 
processes can be cleared up by left-click on the ‘Reset’ button. NB Additional functions such as Plasma , marking etc. must 
be included in your Control File and supported by your machine. Please contact your supplier or FastCAM Inc. to add 
these features  to the software if required  

Kerf compensation ( Adjustment for width of cut )
According to operation requirement, single-click to change compensation to left, none or right. Created path will be adjusted 
according to this kerf compensation setting and the default compensation is kerf left. 

Side ( especially important when processing previous nests with a plate boundary or parts within parts)
Double-click here will select which side(s) of contours has to be processed - inside, outside or both in addition to the kerf
compensation. With this function, it is possible to define different processes for internal and external contours, e.g. to set paths of 
internal contours (inside) first for Oxy cutting and external contours (outside) for plasma cutting. For general applications, side has 
to be set to ‘Both’ with the same process for both internal and external contours.

Available processes
Here is a total list of the FastCAM available processes which have not been set to FastPATH application. They can be selected for 
FastPATH settings by double-clicking on the process or left-clicking the process and then the left arrow. Selections can be cleared 
by left-click on the ‘Reset’ button.

Apply processes
Across whole nest – this option allows the processing of all nested parts according to the defined sequence, e.g. marking for all 
parts followed by cutting typically. With this operation model, distance of rapid travel can be shortened and time can be saved 
from frequent changing of processes.
Part by part – this option allows the operation of selected processes one by one for a single part such as marking followed by 
cutting for one part until all parts are processed which is commonly used in LASER cutting.

Meaning for cutting
Oxy cutting is a process of preheating steel to its combustion temperature, then burning it rapidly by means of a regulated jet of 
oxygen with a gap (known as kerf) left behind. Plasma cutting uses the same principle but thermal energy for heating of steels to 
combustion temperature is converted from electrical energy.
Compensation of kerf is necessary for parts to be with correct dimensions and is defined to be left or right about the line of 
contour as centre.
For kerf setting with left compensation, direction of travel must be counter-clockwise for internal contours and clockwise for 
external contours. For kerf setting with right compensation, direction of travel must be clockwise for internal contours and counter-
clockwise for external contours. All contours should be set using the same principle or dimensional error will occur after cutting.



2. External entry

Lesson 4   Automatic Path Programming



Entry
Piercing is normally required to start cutting and the size of the pierced hole is always bigger than the kerf. That 
means the part will be damaged if piercing is started right on the contour which is obviously not desired. For this 
reason, piercing has to be started away from contours with a line known as an entry.

Exit
To ensure completeness of contours and separation of parts after cutting, an extended line known as the exit is 
normally cut at end of contours.

Position
This drop down is for selecting the position of entry and exit on parts. Available selections are Top left, Bottom left, 
Bottom right, Top right, Top, Right, Bottom and Left. If an obvious corner cannot be identified, the most appropriate 
position will be selected by the program which may be different from what you want. To prevent its happening, a 
point has to be created as the entry on contour. Entrance point will be added at mid point of the first entity if no 
corner has been selected.
Suggestion: To reduce thermal distortion, position of entry at Bottom right is suggested if the zero point of your 
machine is top left.

Corner pierce
Entry will start at corner of contours if this is selected. Otherwise, entry will start from mid point of the closest entity.

Type
Type of entry can be straight line, quarter circle, half circle or none. You can also manually select these within 
FastCAM.

Extension
This option will be automatically activated if entry with quarter circle is selected. This is a new function developed to 
solve the undercut problem in LASER cutting due to fast cutting speed. It can be useful to PLASMA cutting also.

Length
To specify length or radius of the entry here. Unit of input will depend on the FastCAM setting with either a fraction 
or decimal value.

Angle
Input here for angle of the entry at 0, 45 or 90 degree. Straight line entry on arc contour will be appropriately 
created if selected angle is not practical.

On/Off
For selection of entry and exit.



3. Internal entry

Lesson 4   Automatic Path Programming



Internal same as External
Entry and Exit of internal contours will be set to same as those for external contours automatically once this box is selected.

Pierce in Corner
All entries will start from corners closest to the external entries once selected. Closest point will be used if the selected corner does 
not exist.

Break longest entity
The longest entity of internal contours will be selected and broken at the mid point where entry and exit will be added. This
function is suitable for complex rectangles or similar parts. 

Center Pierce
This option enables small holes to be pierced at the hole centre if the hole radius diameter is under a certain value. This allows 
correct piercing of small holes without changing the default value for length of entry. 
For example, the smallest hole that can be pierced correctly will be ½” (12.7mm) in diameter if length of entry is set to be ¼” 
(6.35mm) – equal to radius of the hole if entry starts from centre. 
By specifying a value here, any hole with its radius less than the value will be centre pierced with the entry ignored. However, 
there will be no effect to the current FastPATH setting or piercing for small holes if this radius is set to zero.

Type
Type of entry can be straight line, quarter circle, half circle or none. All of these can also be selected for manual setting in FastCAM 
Editor.

Length
To specify length or radius of the entry here. Unit of input will depend on the FastCAM setting with either fraction or decimal values.

Angle
Enter the angle of the entry at 0, 45 or 90 degree. Straight line entry on arc contour will be appropriately created if selected angle 
is not practical.

On/Off
Turns on or off  selection of entry and exits.

Extension
This option will be automatically activated if entry with quarter circle is selected. This is a new function developed to solve the 
undercut problem in LASER cutting due to fast cutting speed. It can be useful to PLASMA cutting also. Extension adds a small  
straight line to arc entries.



4. Cut Sequence
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Cut Sequence
To specify the sequence for processing parts in a nest.  It can be in the 
order of Columns, Rows or Next closest. NB The direction of the sequence 
depends on the Origin point of the nest (Bottom Left , Top Right etc.)

Nest Start
To define location of the first reference point of the nest. This is normally 
set to bottom left but can be top left, bottom right or top right and is 
applicable to single or multi-plate nesting.

Nest Sweep
Sets the priority for the cutting sequence in nesting when you set the 
sequence as Next Closest or Minimum Rapid This can be from left to right 
or bottom to top and return following the specified direction.



5. Special Setting
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Tag (final uncut part of any contour)
Tag can be used to prevent parts dropping, curling up of parts and overburn of internal holes during cutting.
It also can be used to eliminate or minimize the occurrence of part contours (particularly holes) being 
damaged from notches created by entry/exit of paths.
By turning on this option, type of contour to be tagged and its length can be entered. 

Pre-Pierce ( pre burning of pierce points across a nest, normally heavy plate cutting with Oxy )
For initial processing of parts across the whole plate. Pre-piercing of holes is often done with an oversize or 
worn out nozzle before part cutting. For Laser and Plasma cutting, piercing can also be done at much higher 
values than for cutting. Once piercing is complete the machine is set to the correct values and the precut 
pierces used to complete the nest at optimal  speed and quality. Pierce times should be reset to allow “edge 
starting” on the pre cut holes.   
When using this feature, it is necessary to include appropiate codes in the FastCAM control file (e.g. 
EDGE.CON … *.CON)
/PREPIERCE/              //This is the command for pre-piercing.
M07                          //Cutting start
G01Y5.0                    //Cut 5mm above the pierce hole
G03J-5.                     //Circular interpolation
M08                          //Cutting end
G00Y-5.                     //Return to original pierce location.
Note: Remarks before // are not required, delete these codes if this function is no longer required.

Small Holes (Automatic slowdown of cutting speed when processing small holes)
Drag in the cutting process creates a bevel effect when cutting curves or holes this is especially noticeable 
when cutting small holes I.E. the smaller the hole the greater the effect. Automatic reduction of the machine 
feed rate to a certain percentage, e.g. 2000 x 70% = 1400 for small holes markedly improves cut quality
NB Especially useful on heavy plasma cutting. 

NB Test cutting will determine ideal settings for small holes and entries.

Entry
Adjustment of feed rate for entry to start cutting.
The function of feed rate reduction for small hole and entry is an important processing technique 
to achieve good quality of small hole, arc and thick contours in HD Plasma and LASER cutting.



6. Stitch / Kerf Compensation
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Kerf compensate NC output - Adjust part geometry (this box must be ticked to activate kerf

compensation)

Kerf compensation is necessary in producing correctly cut dimensions. This function is used where 
the programmer wishes the compensation to be done within FastNEST by adjusting part size, not at 
the machine This can significantly speed up program time on many older controllers (EG Burny)
NB Users must ensure accurate Kerf settings are used here, test cutting is advised if unsure.

Kerf
Enter value greater than 0 here if kerf compensated NC output is required. When this setting is in 
effect, G41 or G42 will not appear in the NC output.

Stitch Cut
In situations such as the cutting of a long, thin rectangular piece, large distortion can be result from 
a single complete cut of the contour. To minimize this problem, single or multiple sections of the 
path will be left uncut, creating the link(s) to hold part in position whencutting.

Breakout tabs. 
This feature leaves small breaks in the cut boundary to retain the part in the plate. This is very 
useful recovering small parts on completion of the nest. 

Note: Above functions can also be applied to LASER cutting.



7. Nest Options
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Hole Avoidance
This function is mostly used in Plasma and LASER cutting because cut parts can move or curl up and 
obstruct the torch. Since the cut torch will automatically lower during its movement, its collision with 
the cut parts can occur during travel over the cut areas. By turning on this function, rapid transverse 
of the cut torch over cut items can be avoided.

Sort Marking
Re-arrange the sequence of markings to improve productivity by reducing the time taken to switch 
between processes.
All marking is moved to the start of the program followed by the cutting process improving 
productivity.  

Contour Gap
Special fault tolerance can be accepted by FastCAM which is for non-closed contours restored from 
DXF/DWG/CAM files that cannot be identified with the naked eye. By specifying the maximum 
allowable gap, the software can automatically process the gap as a closed contour.

Outline shown
Select different cutting methods for different applications.
None: default value to cut both the internal and external contours.
Nest Plate: no cutting for edges of plate, cut for external contours of internal parts and keep them.
Silhouette: cut for internal contours of internal parts and keep external contour of the plate.

Cut Short Rapids
Use in the cutting of thick plates to reduce hole piercing. Where the end of one part is close to the 
beginning of the next the process continues cutting. Set the value to a suitable distance based on 
the nest and material.



8. Router / Bridges
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Router (this function is under development)

Bridges 
To minimize the wear and tear on consumable items in 
Plasma or other cutting processes, the number of pierce holes 
can be reduced by using bridge or negative bridge to effect 
continuous cutting of individual parts as an entire item. Under 
normal conditions, the minimum bridge width should be 
larger than the kerf value.



II. FastCAM automatic path programming

1. FastCAM manual output of NC codes (single part)
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Using the FastCAM drawing editor, DXF/DWG files can be 
cleaned and compressed for CAD optimization or new 
drawings can be created from scratch. Manual programming 
can be managed directly through the menu of Program Path,  
followed by Next Path.  Or you can use the FastPATH module 
to manage and generate NC output automatically based on 
the settings selected. Note: FastPATH Settings can be saved 
for all sorts of materials and processes and restored when 
required. 

Automatic output method:
After path setting through the manual or automatic method, 
left-click on the ‘Output NC code’ button.   A dialog box will 
pop up with ‘Save as’ file name. Then there will be the 
option to select Rapid at the start? and Rapid at the end?



2. FastCAM manual output of NC codes (nested parts)
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Notes:
1. DWG restore is not supported for AutoCAD files prepared with version 2006 or above, 

please use ‘save as DXF’ in AutoCAD  to prevent the possible error.
2. Select location of file, file type and file name from the dialog box for loading part into 

FastCAM.
3. For creation of cutting paths, all process parameters have to be set in FastPATH first and 

then click on the Output NC Code button. NB Save settings for future use
4. Type in file name and this will be the file sent to machine for cutting.
5. If required select yes to ‘Rapid at the start?’ and pick a point on screen which is normally 

the intersecting point of the line extensions for length and width of the part – equivalent 
to a corner of the plate for easy point definition and correct cutting of parts.

6. Select yes to ‘Rapid at the end’ for return of torch back to start point after cutting.
7. By answering yes to ‘Leave FastCAM and verify part … ?’, FastPLOT will be called for NC 

codes generation and verification with their cutting and travel paths displayed on screen.
8. Single click on screen will enter the FastPLOT NC Editor. By selecting VIEW, PLOT UP TO 

and trace ON, the execution of NC commands and a step-by-step illustration for cutting 
can be seen by keep clicking left button of the mouse or space bar of the keyboard.

Automatic path setting and NC output for nested DXF/DWG files are very practical functions 
available in FastCAM, particularly applicable to the ship building industry. With nested 
DXF/DWG files prepared by ship design departments, NC codes for different machines can 
be generated directly in FastCAM for cutting. Nested DXF/DWG files can also be converted 
into part drawings for filing together with the processing documents.

Steps:
Click on FILES 
→ DXF RESTORE or DWG RESTORE 
→ un-tick box for ‘Apply Z axis extrusion’ because general cutting machines do not have the 
3rd axis
→ must select  box for CAD CLEAN, CAD FIX and CHECK for ORPHANS



3. FastPLOT Verification

Main functions:

1) Cutting path verification

Simulate the NC file, step-by-step trace on and cut 
dimensions.

2) Cost audits

Audit cost of material and cutting according to the 
programmed result.

3) NC file and codes interchange

Convert NC codes back to part drawing or change 
between NC codes.
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The Value of NC simulation:

To avoid costly reworks, verification and 
simulation is an important function. 

Problems in cutting and related techniques can be 
solved quickly through the verification of cutting 
paths.  The added benefit is that you can obtain a 
simple cost estimate.



1) Cutting paths verification
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In FastPLOT NC editor, select VIEW → PLOT UP TO → trace 
ON

Execution of NC commands and a step-by-step illustration 
for cutting can be seen by keep clicking left button of the 
mouse or space bar of the keyboard.

Key ‘ESC’ can be used to abort plot and screen will return 
to the NC editor after execution.

By selecting Plot Menu from View, diagram can be zoom in, 
zoom out, show distance … etc.



2) Cost audits
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FastPLOT includes a complete cost calculation for 
part processing.

Method:
Select  NC File → Cost → Select NC file for 
calculation from dialog box → type of material and 
enter the necessary data for FastPLOT to calculate 
the machine time, material and total cost. 

For example, items red circled in table have to be 
filled in for calculation to complete.



 Manual Path Programming Exercises

1. Use the manual path method, generate NC outputs for exercise “1.CAM” 
after the CAD optimization and study the result.

2. Use the manual path method, generate NC outputs for exercise “2.DXF” 
after the CAD optimization and study the result.

Requires: set process for cutting, entry with straight line at 8 mm length, angle 
equals zero and no exit. Also try the half/quarter circle and 90 degree angle for entry 
to observe the difference in results.

 Automatic Path Programming Exercises

1. Use the automatic path method, generate NC output for part “1.DXF” after the
CAD optimization and study the result.

Set: Straight line for external entry and exit with length of 8 and 6 mm, quarter 
circle for internal entry and exit with 6 mm radius, 10.1 mm for center pierce hole, 
no overcut, no compensation and follow the default values for the rest. 

2. Use the automatic path method, generate NC output for part “2.DXF” after the
CAD optimization. Verify NC outputs in FastPLOT, check any change in dimensions
and explain any difference.

Set: Straight line for external entry and exit with length of 10 and 6 mm, quarter 
circle for internal entry and exit with 8 mm radius, no overcut, compensation at 1.8 
mm, nest plate for nest options and follow the default values for the rest.
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Benefits of Automatic Pathing in Review:

FastPATH saves programming time by automatically determining the best 
cutting paths based on the settings that you apply. FastPATH has artificial 
intelligence which means it automatically determines the inner-most contours 
and sets them as the first cutting paths. It also has the ability to determine 
which holes to cut first to minimize torch movement. But most importantly, it 
can determine which type of lead-ins and where to place them on the profile 
of your parts. Blended entries and exits are added automatically.

Complicated parts that used to take upwards of 30 minutes to path out 
manually only take seconds when using FastPATH.    Kerf, cut direction, 
internals and externals are determined automatically. Path complex parts or 
an entire CAD nest with a single click of your mouse! 

For multi-process systems, you can even select the order of processing. 
FastPATH will save your settings for different plate styles. Obviously your lead-
ins for 4 inch thick plate are going to be different than 1/4 inch plate. 
FastPATH will allow you to save and restore settings for various styles of plate 
with just a few mouse clicks. 



5 min. break



Module 3  Automatic Nesting

(45 minutes)

Lesson 5: Manual Nesting 
(15 minutes)

Lesson 6: Automatic Mixed Nesting 
(30 minutes)



I. FastNEST Nesting Module, desktop icon  

Main functions:

1) Full Plate and Remnant Nesting -

Implement automatic cutting to improve material 
utilization and nesting for remnants to save material.

2) Nesting Methods –

Manual, Array, Automatic and Mixed Types.

3) High Efficiency Cutting -

Common Edge, Bridging, Common Cutting.
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II. Manual Nesting
1. Set parameters: Input/Output file type, FastNEST parameters, 

Interactive nesting menu.
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Manual and array nesting are the most common, straight 
forward and convenient methods for nesting.

Manual nesting is quite simple and obvious.  Parts can be 
moved to appropriate areas rapidly with the left, down, right 
and up button. Additionally, they can be rotated with the 
rotation button before their movement to the desired 
locations. 

Array nesting will follow the specified rows and columns with 
nesting done in a quick and simple matrix style.

Regardless or whether you choose to use manual or 
automatic nesting, we suggest you master the basic process 
flow for nesting including input file type, output file format, 
nest parameter setting, FastPATH entry and exit. 



II. Manual Nesting

1. Set parameters: Plate list, Save Nest and Retrieve Nest
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Setting for size of plate for nesting, 
selection of remnants, method for 
save and retrieve of nest.



II. Manual Nesting
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Common functions used in manual and automatic nesting:

1. Change the FastNEST parameters and plate data.

2. Movement of parts to left, down, right, up and jostle under 
the FastNEST menu.

3. Movement of parts to left, down, right, up, rotate and array 
under the Interactive menu.

4. With a part selected, double left-click will allow the change 
of its position (XY coordinates) and right-click can rotate 
part while the button is holding down.

5. While parts are being loaded on plate, right click mouse will 
pause the nesting process and selected parts can be deleted 
with the ‘Delete’ key on the keyboard. 

6. With the parts list on screen, double left-click on part name 
will re-activate the dialog box for nest part data.

7. With Interactive mode under the Nest menu selected, parts 
will be added to plate without the display of nest part data.



II. Manual Nesting
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This screen has 80 pieces of part 1 and 9 pieces of part 2 with plate dimension of 2000 width x 
3000 length:

Adding of part 1:
1. Left click on ‘Add Part’ button and select file name from dialog box with part 1 loaded to the 

plate. 
2. Left click on ‘Parts List’ button and change required quantity in the list to 80.
3. Select ‘Move All Down’ under the FastNEST menu to move part to the bottom left corner.
4. With part 1 high-lighted, select ‘Array’ in the Interactive menu and ‘X flipped’ from pop up.
5. Select and delete rest of the parts with only 5 parts showing in a row displayed on the screen.
6. Pick the first part, select ‘Array’ under the Interactive menu followed by ‘Y’ from pop up to create 

nesting for the first column.
7. Select second part at the second column, using the same method described in last step until all 

5 columns are completed.

Alternatively, array nesting can be completed automatically by direct input of the rows and columns.

Adding of part 2:
1. Left click on ‘Add Part’ button and select file name from dialog box with part 2 loaded to the 

plate. 
2. Left click on ‘Parts List’ button and change required quantity in the list to 9.
3. Select ‘Jostle’ from the FastNEST menu to nest parts close together.
4. With part 2 high-lighted, select ‘Array’ in the Interactive menu and ‘Y’ from pop up to add 

another 4 parts in the same column.
5. Create 2nd column of part 2 with ‘Array’ and ‘X’.
6. Rotate and move the last 4 parts to fit in the space as shown, and use ‘Jostle’ to keep parts close.

Final nesting completed as shown.



I. Automatic Nesting
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Automatic nesting method:
The result being shown on the screen was direct 
from automatic nesting without manual interruption 
and can be finished within seconds. In comparison 
with the manual nesting, the automatic option is 
simple, convenient and fast. 

Reminder:
Nesting variables must be set for automatic 
nesting to be more practical with better feed 
utilization such as rotation of parts, inputs for 
FastNEST parameters, nest part data … etc.



II. Automatic Mixed Nesting
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Automatic mixed nesting is a great way to combine 
technology with the knowledge, skill and experience of the 
operator.

In automatic nesting, parts are nested according to the pre-
defined parameters within the software.

For this reason, manual interruption is often used to improve 
material utilisation and the reasonable size of remnants.  This 
is referred to as Automatic Mixed Part Nesting (i.e. manual + 
automatic nesting). Refer to the result shown in the slide from 
Automatic Mixed Nesting.

With Automatic Mixed nesting method, the process of nesting 
can be interrupted at any time for manual nesting by using the 
‘Esc’ key. The user easily returns back to automatic nesting.



 Manual Nesting Exercises

Ex. 1: Apply manual nesting followed by NC output for part 
‘4.CAM’ and study the result. 

- Requirement to set the automatic FastPATH technique

Ex. 2: Apply manual nesting followed by NC output for part 
‘3.DXF’, note the cutting sequence/changes in FastPLOT and check 
costing data for job record.

- Requires to set the automatic FastPATH technique

 Automatic Mixed Nesting Exercises

Ex. 1: Apply automatic mixed nesting followed by NC output for 
part ‘6.DXF’ and study the result. 

- Requires to set the automatic FastPATH technique

Ex. 2: Apply automatic mixed nesting followed by NC output for 
part ‘5.DXF’, observe cutting sequence/changes in FastPLOT. 
Check costing data and compare with the result from Ex. 2 of 
manual nesting to understand the benefits from automatic mixed 
nesting …

- Requires to set the automatic FastPATH technique (must be with  
same setting as Ex. 2 of the manual nesting)

Lesson 6  Automatic Mixed Nesting



5 min. break



Lesson 7: Automatic Common Cutting (15 minutes)

Lesson 8: Plasma Bridging (15 minutes)

Lesson 9: Automatic Continuous Cutting 
(15 minutes)

Lesson 10: Nesting exercises (15 minutes)

Module 4   Optimized Cutting 
(45 minutes)



NC cutting efficiency is mainly affected by: 

1. Hole piercing in Oxy flame cutting. 

2. Piercing and replacement of the electrode in Plasma cutting. 

The intention of high efficiency cutting is to reduce the piercing of 
holes in Oxy and Plasma cutting.  This offers a productivity 
improvement and directly helps save consumables & parts.

Optimized Cutting options:

1.Common cutting – typically applies to oxy, plasma, LASER and water 
jet cutting. With common cut nesting, 30% of cutting paths can be 
saved and the amount of pre-heat and pierce holes can be reduced.

2.Bridge cutting – mainly used in plasma cutting for continuous cutting 
to reduce hole piercing and cost of consumables.

3.Continuous cutting – used in oxy, plasma, LASER and water jet 
cutting.  Reduces pre-heat and hole piercing and offers productivity 
improvements by connecting entry and exit of parts in nesting for 
continuous cutting.



I. Automatic common edge cutting
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Application steps for common cutting:

1. Open the FastNEST software.

2. Click on the ‘Change Parameters’ button, set part to part distance to 1 time 
of the kerf value, select common cut for Nest Type and enter.

3. Enter/Change size of the plate, add and nest parts on plate.

4. NC output.

5. Check and verify start point and cut path of common edge parts before 
start of cutting on machine.

Note:

1. Common cut nest type must be selected before the addition of parts on 
plate for this function to work.

2. The effect of thermal distortion caused from location of entry and direction 
of cutting paths.

3. Except the use of normal pre-heat time for the first pierce hole, others 
have to follow the edge pre-heat guideline and start cut within 1 minute.

Reminder:

For automatic common cutting, kerf will be compensated by the software 
according to part to part value specified in the FastNEST parameters (i.e. 1 
time of the kerf value in diameter).



Common Cut Pairs

Common cut pairs are defined by joining two 
identical parts along a common straight 
boundary. This can reduce the cutting and 
halve the piercing. It is used most often in 
shipbuilding as it is common to encounter 
left and right hand pairs. 



II. Mixed Automatic Common Edge Cutting
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Mixed applications (with kerf compensation in output)

1. Start FastNEST from icon or the start menu.
2. To minimize gaps between parts, clear selection for ‘Existing Entries’ shown at bottom left corner of 

the Set File Types dialog box.
3. Open the nest parameters box, activate common cut for nest type, change ‘Part to Part’ distance to 

common edge value (i.e. 1 time of the kerf value) and click enter with the common cut value 
displayed at right hand side of the toolbar.

4. Add and nest required parts for common edge cutting (note they have to be arranged together) then 
use the ‘Jostle’ function to adjust parts close to each others (Note: When using automatic nesting, it is 
necessary to check if position and start point of nesting are the same or it may not be possible for 
common cut to occur).

5. Re-enter the ‘Part to part’ value for standard nest type (i.e. must be greater than 2X kerf value) and 
change the Nest Type back to Standard.

6. Add remaining parts which do not require common edge cutting and proceed nesting. 
7. Back to the nest parameters box, set ‘Part to part’ distance back to the common cut value and re-

activate common cut for nest type.
8. Output NC (this must be done while common cut nest type is active).
9. Verify, check and confirm there is no error in cutting positions and paths before NC is sent to machine 

for cutting.

Note:

1. Function of re-sequence cannot be reused in above steps.
2. Automatic nesting will not be affected after the last activation of common cut nest just before the NC 

output.
3. Take note of following when using the common cut function.

i) The effect of thermal distortion from position of entries and direction of the programmed 
paths.
ii) Except the use of normal pre-heat time for first hole of common cut and rest of holes for 
standard cut, edge pre-heat should be used for other part of common cut nests i.e. max. 1 
minute before start of cutting.

Reminder:

For automatic common cutting, kerf will be compensated by software according to part to part value 
specified in the FastNEST parameters (i.e. 1 time of the kerf value in diameter).



II. Mixed Automatic Common Edge Cutting
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As illustrated, the common cut nest process has 
not been used for parts enclosed in red rectangles.

Description:
To prevent incorrect piercing of holes on parts due 
to ‘Part to part’ distance set in FastNEST is less 
than length of entries and exits, a logical 
adjustment has been added to reduce lengths of 
entries and exits same as the ‘Part to part’ 
distance in new versions.



I. FastCAM Bridges
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Steps in using bridging in FastCAM:
1. Change output file type in FastNEST to the CAM type.
2. Use of automatic mixed nesting and output as CAM file.
3. Open the CAM file in FastCAM, select ‘Constructs’ → ‘Overcut 

Bridge’ or ‘Simple Bridge’ → set bridge width → Enter.
4. Select outer contour of entities to be linked with bridge and form a 

new external contour.

Beware:
1. Travel direction of entry and external contour in relation to thermal 

distortion.
2. Position of bridges and travel direction of contours in relation to 

thermal distortion.
3. Beware of potential problems from newly created internal contours 

and ensure they will be cut first according to the principle.
4. Beware of the formation of dead loops.

The Bridge function for plasma cutting is used to link parts into 
groups with bridges such that the linked parts can be cut 
continuously with only one pierce hole. This function aims at 
reduction of the pierced holes for lower consumable costs and higher 
productivity plus minimization of heat distortion.



Bridging Information Update for v5.10

FOUR different types that will be included in the Professional Edition. Bridging can be 
combined with other processes such as line marking and text marking. 

 1) (Traditional) Bridging. A simple positive bridge is where parts are connected 
together linked by two parallel cuts (bridge). Bridges allow continuous cutting and are 
traditional in many shipbuilding applications. The result is much faster cutting. Parts are 
left joined, but this can be an advantage in some circumstances. These include making 
assemblies, moving the parts as a group and minimizing part movement (appropriate 
for lighter materials or thinner materials). 

 2) Overcut or Negative Bridging allows for continuous cutting with the immediate 
separation of parts. This is a FastCAM® invention that has the advantages of bridging 
but cuts out the bridge on the return. Previously available in the FastCAM® drawing 
editor, this function is now available in FastNEST® where it is perhaps more intuitive. 
Selecting this function will deliver a speed increase on many nests and result in a 
reduction in piercing making it a feature of interest to a wider range of customers. 

 3) Skip Bridging. Here you have additional piercing and the parts are held together by 
a bridge but the bridge is not cut. This can be used for routing aluminum, as it prevents 
vibration but does involve piercing on the edge, which is fine for routing. You actually do 
much more piercing and save nothing on cutting, so it is a device mainly to prevent 
vibration and movement. A simple gap bridge forms much the same function for lighter 
materials where the resultant tabs can be broken manually. In this case, additional 
pierces are required rather than fewer. (This function is aimed at aluminium routers but 
can be used in any instance where the programmer does not want the bridge to be cut). 

 4) Skip with Entries. As with Skip Bridging, but pierces are away from the part edge. 



II. FastNEST Bridges
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Steps:
1. Select ‘Add Pierce’ before nesting in the ‘Set file types’ box, 

followed by ‘Set Pierce’ to set the position of entry in FastPATH.
2. Select ‘Bridge Nest’ for Nest Type in the ‘Nest Parameters’ box 

and enter width of bridge in the pop up if it is the first time to use 
this function. Then the amount of bridge width will be displayed 
on right hand side of the toolbar with the ‘Add Bridge’ button 
activated between the Gas Axe and Email button.

3. Add and nest parts as normal, click on the ‘Add Bridge’ button and 
select Add, Delete, … from the pop up.

4. Pick outer contours of parts needed to be linked, build a bridge 
between 2 contours to form a new external contour.

Beware :
1. Travel direction of entry and external contour in relation to 

thermal distortion.
2. Position of bridges and travel direction of contours in relation to 

thermal distortion.
3. Beware of potential problems from newly created internal 

contours and ensure they will be cut first according to the 
principle.

4. Beware of the formation of dead loops.
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Steps:
1. Adding of parts as normal with FastNEST.
2. To facilitate continuous cutting, you must consider the 

position of entry/exit and adjust their position as required 
(Position of entry/exit can also be changed during the NC 
output process).

3. Select ‘Cut Short Rapids’ under Nest Options of the 
FastPATH settings and enter the shortest distance between 
exit of last part and entry of next part – distance of Short 
Cut value.

4. NC output and plot for verification.

Pay attention to the following before the use of this function:
1. Travel direction of entry and exit in relation to thermal 

distortion.
2. Travel between the entry and exit will not pass over 

contour of parts.
3. Refer to demonstration for practical steps.



1. With common cutting, prepare nesting for part ‘6.DXF’ and 
‘7.DXF’ then generate the NC outputs. Using the same 
parameters, check in FastPLOT and record the costing data.
Requirement : Kerf 2 mm, Plate size 6,000 mm and 4,000 
mm, Part quantity 30 and 18.

2.With mixed common cutting, prepare nesting for part ‘6.DXF’ 
and ‘7.DXF’ then generate the NC outputs. Using the same 
parameters, check costing data in FastPLOT and compare 
result from Ex. 1.
Requirement : Kerf 2 mm, Plate size 6,000 mm and 4,000 
mm, Part quantity 30 and 18.

3.With bridge cutting turned on in FastNEST, prepare nesting for 
part ‘6.DXF’ and ‘7.DXF’ then generate the NC outputs. Using 
the same parameters, check costing data in FastPLOT and 
compare result from Ex. 1.
Requirement : Kerf 2 mm, Plate size 6,000 mm and 4,000 
mm, Part quantity 30 and 18.

Lesson 10   Nesting Exercises



Common Cut Information Update

In FastCAM® Professional 
v5.10, we have 
introduced the ability 
to completely 
common cut nest. 
Compared with 
traditional nesting of 
separate parts each with 
their own external entry 
and exit, FastCAM® 
Common Cut Nest gives 
you the ability to set the 
part spacing to exactly 
the cut width before 
nesting. See next slide.



Compared with traditional nesting of separate parts each with their own external 

entry and exit, FastCAM® Common Cut Nest gives you the ability to set the 

part spacing to exactly the cut width before nesting. 

FastCAM® v5.10 achieves 'zero gap' common cutting by cutting entire nests 

using a start on (part) edge approach. In many nests this will usually eliminate 

piercing time and halve cutting time. Intelligent strong/weak analysis logic is 

built into the software to minimize part movement however there is the 

potential for slightly damaged parts so part quality is a consideration. There is 

also the potential of damage to the part if an edge start command is not 

present in the NC control. However it offers the possibility of many common 

cuts in a nest of largely rectilinear parts where quality is not the main concern. 

It is dramatically faster with far less piercing. For rectilinear parts such as 

nests of rectangles, the saving in piercing can be 5x. The saving in cutting can 

be 2x, yielding gains of 10x in total processing speed! 

Like any new technology, there are advantages and disadvantages depending on 

the application. The NC programmer can quickly weigh up the pro's and con's 

on a job by job basis. Certainly if you're cutting barbeque plates or similar 

then the efficiencies using the new Common Cut Nest feature can be 

remarkable. 



1. Common cutting,
2. Bridge cutting, and
3. Continuous cutting.

Use of these functions yields improvements such as:
1. Reduction of pierce holes effectively by 70%,
2. Reduction of cutting paths by 30%,
3. Improvement of cutting efficiency by 40%, and
4. Reduction of consumable items such as the plasma torches, 

electrodes and LASER lens by 40%.

Optimized Cutting in Review:

FastCAM offers optimized cutting techniques and continues to 
develop new methods for:



5 min. break



Module 5  FastCAM Solutions

FastCAM software isn't limited to drawing and 
nesting! One of the benefits of having the largest 
range of software for steel fabrication means that 
over the years, we've solved many unique and 
complex fabrication problems. Our software is 
often a central aspect of the total engineering 
solution. 

We highlight a few popular programs that can be 
used in conjunction with FastCAM or purchased as 
stand alone programs.



Automate fabrication/weld calculation and layout of 

multi segment heavy plate transitions, boilers, 

blowpipe, power, transitions. Huge saving of skilled 

manpower required to calculate unfolding and fitup. 

I. FastSHAPES® Heavy Plate Development



The Fast Way to Profile Pipe Ends for 
Pipe to Pipe & Reticulation

II. FastPIPE™

FastPIPE simplifies & speeds All Types of 
Pipe Development & Estimation work 

Produces Wrap around templates with 
full Weld Preparation details



Saves hundreds of hours in the design stage of complex space frame 
developments. Complete structural frames can be completed in days! 

Of equal value, the extraction of fabrication data needed for processing is 
simple!

III. FastFRAME® Complex Tubular Space Frames



For Burning, Shearing, Sawing, Drilling 

IV.FastCAM® QE™
Optimized Estimates for Processed Steel

Comprehensive, Purpose Built 
Quotation System for Metal 
Service Centers.   

Contains both Linear and Plate 
based optimization with the 
least percentage scrap. 

Produces an Email or fax ready quote after nesting, with full 
allowance for all remnant, scrap and processing costs.

Profiling, Shearing: Parametric, True Shape, Rectangular
Sawing, Drilling for Long products, Beams, Channels, Angles etc.

http://www.fastcamusa.com/new/quoter/


V. FastCOPY® for Parts & Drawings 

Offline system for fast, 
accurate conversion of 
existing parts, templates, 
or drawings into DXF & NC 
code ready for ‘best 
quality’ cutting.  Easier 
than an electronic eye.  
Includes a new design 
lightweight portable ‘plug 
and play’ digitizer for ease 
of use and storage.   Packs 
away in minutes.

Adds value to any busy service center 
or business needing to copy and 
profile cut complex parts or 
precision artwork from metal. 
Destroy/archive old paper drawings 
and instantly retrieve templates.   
Easy to use.

http://www.fastcamusa.com/new/posts


 Optimized layouts for general cutting of 

lengths or rectangles, shears and saws (plate & 

bar).  Nests then prints graphic cutting lists.  DXF 

output.  Use for basic costing information.

VI. FastCUT® Optimizer 

Saves material and 
operator time.   
Improves time to 
quote.  Reduces 
cutting errors and 
layout time.

http://www.fastcamusa.com/new/fastcutmetal/


Minimizes stock holding of partially processed plates and uses the most cost 
effective plate stock for the job. Fast stock take & auditing system.  

VI. FastTRACK® Plate Tracking 



VII.  FastCAM Bevel for Weld Ready Parts

Ultra simple automatic 3-Pass beveling to achieve weld ready parts (true K,Y 
engineering parts for heavy plate forming). 



Some features that you can add to your FastCAM® System 

include: 

 Text marker is useful plate marking software for NC machines fitted with Scribes, 
Punch Markers, Plasma Etch markers & Ink-Jet.  Converts text & numbers into 
stroke font movements. Uses stroked characters for minimal machine movement. 
Ideal for lasers and/or plasma with low power torches.  Requires FastCAM®.

 FontGEN converts ‘Windows’ fonts into a format for NC cutting. Ideal for cutting all 
styles of letters and fonts such as used for signwriting etc.

 Outline converts pictures or shapes ready for cutting. Ideal for converting non-
dimensioned artwork into cutting files. Ornamental iron work, signs, machinery 
logos etc.  Reads most graphic formats.

 NC Collision Checker replaces the visual checks in both FastNEST and FastPLOT to 
be computer based and automatic.  Of value in big and complex nests where a 
small overlap can easily be missed resulting in expensive cutting mistakes.

 FastLINK provides a fast DNC file download link from older controllers which speeds 
up processing.



Did you know that FastCAM® Profiling Systems 
support multiple posts? 

If you replace or add another type of cutting machine you 
don't need to change your programming system! 

If you are on an Annual Service Agreement, we will support 
you getting your machines up and running! If you are 
not on a Service Contract we will provide technical 
support at current rates. We invite you to call us to 
discuss machine specific details. 

Note: Excludes FastCAM® Systems marked as 'OEM' 
versions (Specific machine bundled software). 



FastCAM programs that use a physical hardware security lock or 
dongle are:

FastCAM   FastPLOT   FastNEST  FastSHAPES  FastTRACK   
FastCOPY   FastLINK

 What happens if you make changes to your PC and you use one 
of these 'dongles'?

 Changes to your network card or any other internal hardware, 
upgrading your operating system etc should make no difference. If you 
buy a complete new PC then just make sure that you remove the 
dongle from the old PC and attach it to the new one. 

 If you require a USB dongle you only need to purchase a new holder 
(outer case) from us. We will also send a simple instruction sheet on 
how to transfer your unique ID 'button' from one holder to another. 



Today FastCAM has many more products encompassing many 
industries and distribution points and FastCAM is used in many 
different environments around the world.

• STEEL SERVICE CENTERS 
• STEEL FABRICATION 
• METAL FABRICATION 
• MINING 
• CONSTRUCTION 
• SIGNCUTTING 
• WOODWORKING 
• FLAT GLASS 
• EDUCATION

Conclusion



Please visit www.fastcam.com

for more information.

End of Tutorial

Thank You!

http://www.fastcam.com/

